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Hantek 6022BL

General Safety Summary

Review the following safety precautions carefully before operate the device to avoid any
personal injuries or damages to the device and any products connected to it. To avoid
potential hazards use the device as specified by this user’s guide only.

To Avoid Fire or Personal Injury.

€ Use Proper Power Cord. Use only the power cord specified for this product and
certified for the country of use.

€ Connect and Disconnect Properly. Do not connect or disconnect probes or test
leads while they are connected to a voltage source.

€ Connect and Disconnect Properly. Connect the probe output to the measurement
device before connecting the probe to the circuit under test. Disconnect the probe
input and the probe reference lead from the circuit under test before disconnecting
the probe from the measurement device.

€ Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

€ Use Proper Probe. To avoid shock hazard, use a properly rated probe for your
measurement.

€ Avoid Circuit or Wire Exposure. Do not touch exposed connections and
components when power is on.

€ Do Not Operate With Suspected Failures. If suspected damage occurs with the
device, have it inspected by qualified service personnel before further operations.

€ Provide Proper Ventilation. Refer to the installation instructions for proper
ventilation of the device.

Do not operate in Wet/Damp Conditions.
Do not operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.
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Chapter 1 Getting Start

The oscilloscope is small, lightweight, no external power required, portable oscilloscopes!
The oscilloscopes is ideal for production test, research and design and all of the
applications involving analog circuits test and troubleshooting, as well as education and
training.

In addition to the list of general features on the next page, this chapter describes how to
do the following tasks:

System Requirements
Install software
Install driver

General Features
Probe compensation

Functional Check

¢

¢

L 4

¢

€ General Check
¢

L 4

€ self calibration
¢

Accessories
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1.1 System Requirement

To run the oscilloscope software, the needs of computer configuration are as follows:

Minimum System Requirements
Operating System
Window XP/Vista/Win7/Win8

Processor

Upwards of 1.00G processor

Memory
128M byte

Disk Space
500M disk free space

Screen resolution
800 x 600

Recommended Configuration
Windows XP SP2 System

2.4G Processor

512M Byte Memory

80G Disk Space

1024 x 768 or 1280 x 1024 resolution
DPI Setting: Normal Size (96DPI)
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1.2 Install Software

Caution: You must install the software before using the oscilloscope.

1.  While in Windows, insert the installation CD into the CD-ROM drive.
2. The installation should start up automatically. Otherwise in Windows Explorer, switch
to the CD-ROM drive and run Setup.exe.

Hantek6022BL Installation

Initializing Wise Inztallation Wizard. .

3. The software Installation is started. Click 'Next' to continue.

43 HantekG022BL

YWielcome to HantekB0Z22BL Setup program. This program will
inztall Hantek G022EL on vour computer.

[t iz gtrongly recommended that you exit all Windows programs
befare running thiz Setup Program.

Click Cancel to quit Setup and cloge any programs you have
running. Chek Mest to continue with the Setup program.

WARMIMG: Thiz program is protected by copuright law and
international treaties.

Idnauthonzed reproduction or distribution of thiz program, or any
portion of it, may result in severe civil and criminal penalties, and
will be prozecuted to the masimum extent possible under law.

Cancel |

User’s Manual 4
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4. Choose a destination directory. Click 'Next' to continue.

Destination Location

Setup will install HantekBOZZEL in the following folder.
Toinstall into a different folder, click Browse, and select another folder.

Y'ou can chooge not ta inztall HantekBOZ2BL by clicking Cancel tao exit Setup.

D eztination Faolder

C:AProgram Files'HantekB0Z22BL Browsze. .

ize Installation Wizard?

¢ Back Cancel

5. Check the setup information. Click Next to start copying of files.

1 Hantek6022BL

Start Installation

Y'ou are niow ready toinstall HantekB0226L.

Click. the Mext button ta begin the installation or the Back button to reenter the installation
information.

ize [nstallation \wizard?

¢ Back Cancel
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6. This Status dialog is displayed during copying of files.

IHant ek6022E1

Installing

— Current File

I:':ll:l_';'""lg I:||E.

E:\Program FilezHantekB022BProgramtHantek 60228 L k] 00w, dil

— Al Files

Time Remaining 0 minutez 3 seconds

ize Installation ‘izard?

¢ Back Mewt »

7. Updating Your System Configuration.

% Updating Swstern Configuration, Please wiait. .
g

8. The installation is complete.

2 Hant ek6022BL [zj

HantekB022BL has been successfully installed.

Click the Finish button ta exit this installation.

User's Manual 6
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1.3 Install Driver

1. Press the H/P button down.

2. Connect the A-Type Plug of USB cable to your PC’S USB port.

‘

3. Connect the B-Type Plug of USB cable to USB port.

4, New hardware is found.

i) Found New Hardware *
Hantek w00 DERTWER 1

5. New hardware search wizard starts.

User’s Manual 7
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Found New Hardware Wizard

This wizard helps you install software for:
Hantek xooc DRIVER 1

‘) If your hardware came with an installation CD
<& or floppy disk. insert it now.

What do you want the wizard to do?

(O Install the software automatically (Recommended)
(&)ilnstall from a list or specific location [Advanced}

Click Next to continue.

[ < Back ][ Next > ][ Cancel ]

6. New hardware search wizard starts to search the driver.

Found New Hardware Wizard

Please choose your search and installation options.

(%) Search for the best driver in these locations.

Ize the check boxes below ta limit or expand the default search, which includes local
pathz and removable media. The best diver found will be inztalled.

[ 1 5earch removable media [floppy, CO-ROM...]

Include this location in the search:
cuments and Settings\AdminiztratorD eskiopDriverflies

() Don't gearch. | will chooze the driver ta install.

Chiooze this option ba select the device driver from a list, Windows does not guarantes that
the driver you chooze will be the best match for your hardware.

¢ Back “ Mewt > J[ Cancel
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Found New Hardware Wizard

Please wait while the wizard searches...

W Hantek xoo DERIVER 1

Cancel

7. New hardware wizard installs “DRIVER”.

Found New Hardware Wizard

Please wait while the wizard installs the software... ‘\

B2

=7 -

Setting a system restore point and backing up old files in
case your system needs to be restored in the future.

User's Manual 9
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8. The wizard has finished installing for “DRIVER”.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished installing the software for:

[ Hantek scoo DERIVER 1

Click Finish to close the wizard.

9. New hardware is found.

V

i) Found New Hardware
Hantek xoooc DERIVER 2

10. Found new hardware Wizard. Select “Install the software automatically”.

User’s Manual 10
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Found New Hardware Wizard

This wizard helps you install software for:
Hantek oo DRIVER 2

) If your hardware came with an installation CD
4 or floppy disk. insert it now.

What do you want the wizard to do?

(&) Install the software automatically (Recommended)
(Oilnstall from a list or specific location [Advanced}

Click Next to continue.

[ < Back ][ Next > ][ Cancel ]

11. New hardware wizard installs software and finish new hardware search wizard.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished installing the software for:

Eﬁ Hantek oo DERIVER 2

Click Finish to close the wizard.

User’s Manual 11
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12. Your new hardware is installed and ready to use.

1) Found New Hardware X

Your new hardware is installed and ready to use.

1.4 General Features

€ Maximum real-time sample rate: 48MSa/s

€ Memory depth: 1Mbytle/channel

€ Built-in Fast Fourier Transform function(FFT);

€ 20 Automatic measurements;

€ Automatic cursor tracking measurements;

¢ Waveform storage;

€ User selectable fast offset calibration;

€ Add, Subtract, Multiply and Division Mathematic Functions;
¢ Adjustable waveform intensity, more effective waveform view;

€ User interface in several user-selectable languages;

User’s Manual
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1.5 General Check

Please check the instrument as following steps after receiving an oscilloscope:

*

Check the shipping container for damage:

Keep the damaged shipping container or cushioning material until the contents of the
shipment have been checked for completeness and the instrument has been checked
mechanically and electrically.

Check the accessories:

Accessories supplied with the instrument are listed in "Accessories"” in this guide. If
the contents are incomplete or damaged, please notify the franchiser.

Check the instrument:

In case there is any mechanical damage or defect, or the instrument does not operate

properly or fails performance tests, please notify the franchiser.

1.6 Probe Compensation

Perform this function to match the characteristics of the probe and the channel input.

This should be performed whenever attaching a probe to any input channel at the first

time.

2

*

*

From the “Probe” menu, select attenuation to 1:10. Set the switch to “X10” on the
probe and connect it to CH1 of the oscilloscope. When using the probe hook-tip,

insert the tip onto the probe firmly to ensure a proper connection.

Attach the probe tip to the Probe Compensator and the reference lead to the
ground connector, select CH1, and then press the “AUTOSET* button into the

menu or the toolbar.

Check the shape of the displayed waveform.

Correctly Compensated

User’s Manual 13
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Over compensated

Under Compensated
m If necessary, use a non-metallic tool to adjust the trimmer capacitor of the probe for

the fattest square wave being displayed on the oscilloscope.

m Repeat if necessary.

WARNNING: To avoid electric shock while using the probe, be sure the perfection of the
insulated cable, and do not touch the metallic portions of the probe head while it is

connected with a voltage source.

1.7 Function Check

Perform this functional check to verify that your oscilloscope is operating correctly.

€ Connect the oscilloscope
You should connect the A-Type Plug of USB cable to your PC USB port and connect
the B-Type Plug of USB cable to oscilloscope USB port.

User’s Manual 14
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€ Input asignal to a channel of the oscilloscope
The oscilloscope is equipped with dual channels.

Please input signal in the following steps:

Set the attenuation switch on the probe as 10X and connect the probe on the oscilloscope
with CH1. Aim the slot in the probe connector at the faucet on BNC of CH1 and insert,
then, turn right to lock the probe. Finally, attach the tip of probe and ground nip to the
Connector of Probe compensator.

1. Setthe CH1 probe attenuation of the oscilloscope to X10. (The default is X1).

2. Attach the tip of probe and ground nip to the Connector of Probe compensator. A
square wave will be displayed within a several seconds. (Approximately 1 kHz,
2V, peak- to- peak).

3. Inspect CH2 with the same method. Repeat steps 2 and 3.

User’s Manual 15
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1.8 Self Calibration

The self calibration routine lets you optimize the oscilloscope signal path for maximum
measurement accuracy. You can run the routine at any time but you should always run the
routine if the ambient temperature changes by 5°C or more. For accurate calibration,
power on the oscilloscope and wait twenty minutes to ensure it is warmed up. To
compensate the signal path, disconnect any probes or cables from the input connectors.
Then, access the “Menu -> Utility -> Calibration” option and follow the directions on the
screen. The self calibration routine takes about several minutes.

1.9 Accessories

All the accessories listed below are standard accessories for the oscilloscope:
€ Probex2 (1.5m), 1:1, (10:1) Passive Probes

€ AUSB Cable

€ APC software CD of the oscilloscope

User’s Manual 16
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Chapter 2 Operating Basics

The User’s Interface
The Menu System

The Vertical System
The Horizontal System

The Trigger System

* 6 6 O o o

Input Connector

User’s Manual
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2.1 The User’s Interface

on the desk after you finished the software setting

and equipment connecting. Then click icon Hentelf02ZEE 4 10 Hantek6022BE mode.

r-.-1|.|Iti function virtual signal analyzer |E|

Hant elBOZEEE Hant elBOZZEL

[P Hartek 6022BE Ver 1.0.2
[Este

PEEE TR P T

8 X 4 St

In addition to displaying waveforms, the display area is filled with many details about the
waveform and the oscilloscope control settings.
1. The Main Menu
All settings can be found in the main menu.
The Toolbar
Control Panel
The Horizontal Panel
The user can change Time/Div, format in the panel.
5. The Vertical Panel
The user can turn on/off the CH1/CH2. Also the user can change the CH1/CH2

User’s Manual 18
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volt/div, coupling and probe attenuation.
6. The Trigger Panel
In this panel, the user can change the trigger mode, sweep, source and slope.
Displays the system time.
Displays Sample Rate
Displays the main time base setting.
10. Displays the CH2 information
Readouts show the coupling of the channels.
Readouts show the vertical scale factors of the channels.
A “B” icon indicates that the channel is bandwidth limited.
11. Displays the CH1 information
Readouts show the coupling of the channels.
Readouts show the vertical scale factors of the channels.
12. Displays Output Window
13. The markers show the reference points of the displayed waveforms. If there is
no marker, the channel is not displayed.
14. The same as 13.

15. Measure Window.

User’s Manual 19
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2.2 The Menu System

The Main Menu of Hantek6022BE:
File V¥iew Heorizental Vertical Trigger Displar Cursor

1. File: Load or Save data, setup

ile | View Horizontal Ver

_____

ac

Print Preatriows ]+
FI1ONT FIEV1EW LTTl
Primt Tad1r

Evip = ~

FILOT aETUp.

Rr 5+ C4++14+R
BELT LTTA E

2. View: Change the user interface

View | Horizontal Vertical
Toolbar

tatus Bar

{[E3]

User’s Manual
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5. Trigger: Set the trigger system

Interpoclation [

Languzgs [

9. Help: Turn on help file

User’s Manual 21
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2.3 The Vertical System

Click “Vertical” in main menu.
The following figure shows the vertical system menu. It shows the vertical parameters

setting.

1. CHL1: Leads to the setting of the CH1 parameters

2. CH2: Leads to the setting of the CH2 parameters

Use the left mouse button to dragging the channel icon to set the vertical position offset
precisely.

2.4 The Horizontal System

Click “Horizontal” in main menu.
The following figure shows the Horizontal System window. It shows the horizontal

parameters settings.

1. Time/DIV: leads the setting of the time base parameters
2. Format: leads the setting of the horizontal format parameters
The time base ranges of the oscilloscope is listed as follows. The horizontal scan speed is

from 4ns/div to 1hour/div.

In the “Format” menu of the “Horizontal” menu, select the display mode to Y-T, X-V.
Farrmst

YT W

User’s Manual 22
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2.5 The Trigger System

Click “Trigger” in main menu.

Mode: Sets the trigger mode to Edge trigger

Sweep: Selects the trigger sweep mode to AUTO, NORMAL or SINGLE

Source: Selects the trigger source to CH1, CH2.

Slope: Selects the edge trigger slope to Positive or Negative slope

The user can drag the trigger icon to adjust the trigger level and the trigger level will be

displayed on the top right corner.

User’s Manual 23
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2.6 Input Connectors

Input Connectors:

1. Button: Press the button down to run Hantek6022BL hardware. Before you connect it
to your computer, press it down.

2. USB PORT: Connect the B-Type Plug of USB cable to this port.

CH 1/CH 2: Input connectors for waveform display.

GND.: a ground terminal

CAL.: Probe compensation output.

User’s Manual 24
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Chapter 3 Understanding Function

€ Set Oscilloscope

€ Set Vertical System
€ Set Horizontal System
€ Set Trigger System

€ Measure Signal

€ Utility Function

€ The Display System
€ Save/Load

¢ Print

User’s Manual 25
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3.1 Set Oscilloscope

Save Setup
The oscilloscope software saves the current setup before you close the oscilloscope

software. The oscilloscope recalls this setup the next time you run the software. You can

use the “Save Setup” menu to permanently save up to several different setups.

Load Setup
The oscilloscope can recall the last setup before the oscilloscope software was running,

any saved setups, or the factory setup. You can use the “Load Setup” menu to

permanently recall a setup.
Factory Setup
The oscilloscope software is set up for normal operation when it is shipped from the

factory. This is the factory setup. To recall this setup, push the “Factory Setup” menu.

3.2 Set Vertical Systems

Click “Vertical” in main menu

The Vertical Menu function:

€ Turn ON/Off: Turn on/off the channel
¢ \olt/DIV: Select the channel voltage/div

¢ Invert: Turns the displayed waveform 180 degrees

» Change Volt/DIV
You can click “Volt/Div” in “CH1/CH2” Menu to select the voltage

You can also change “CH1/CH2” voltage in sidebar
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1.00% W

20.0mY
S0.0mY
100mY
200m*
a00ms

200%
2.00%

You can left click and drag the mouse on the green knob or the yellow knob to change the
voltage.

» Probe Attenuation Setting

Select the attenuation factor for the probe. To check the probe attenuation setting, toggle
the probe menu to match the attenuation factor of the probe.

This setting remains in effect before you changed again.

The probe setting window in the sidebar:

Note: The attenuation factor changes the vertical scale of the oscilloscope so that the
measurement results reflect the actual voltage levels at the probe tip.

> Invert

The invert function turns the displayed waveform 180 degrees, with respect to the ground
level. When the oscilloscope is triggered on the inverted signal, the trigger is also inverted.
Click “Invert” in vertical.

Wertical
CH1
20.0my bt
X1 4 [ irnvert
CHz2
2.000 "
x1 b’ [ irvert
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Turn off invert
|:| Invert

Turn on invert

The following picture shows the waveform before inversion:

CHT = 1.00% CH2 1.000 Time: 100.0us  Sample Rate: 1MHz

The following picture shows the waveform of inversion:

CH1 = 1.00% CHZ = Time: 100.0us  Sample Rate: 1hHz

User’'s Manual 28
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3.2.1 Set Math

Click E in Toolbar.

The MATH Menu:

Hath & |
Setting
[ ] i OFF
Ciperate

............ Source & CH1 w

© m+B
Source B CH2 [

) A-B
) AxB olt £ Dl 1.00% w

) ArB

O FFT

¢ Turn On/Off: Turn On/Off the MATH Channel.

€ Source A/B: Set the sources of the math channel.

€ Operate: Set operates type of the math channel.

The mathematic functions include addition, subtract, multiply and division for CH1 and
CH2.

» Operate

Four Types:

A+B Add source A and source B
A-B Subtract source B from source A
AxB Multiply source A by source B
A/B Division source A by source B

In this function, use the addition, subtraction, multiplication and division function to

operate and analyze the waveform.
Select the operate type in the Operate menu. Select source A and B. Then adjust the

vertical scale and offset to view the math channel clearly. The mathematic result can be

measured by the measure and the cursor.
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The Math Function Display:
Trig'D 4 0.00uy

CHY1 == 2.00v CHZ == 2.00 Time: 500.0us  Sample Rate: 1MHz

Fast Fourier Transform Function

To use the FFT mode, you need to click @ in Toolbar to open the FFT setup window.
The FFT setup window:

Hath .

|:| Qb FOFF
Operate

Source CHA1 b

) A+B
C' . WinE oy Rectangle e d
) AxB Scale Wrms b
QO A/B WERT Scale | 1.00v v
""""" HOR| Scale *1 W

You can select the Source channel, Window algorithm, FFT number, and FFT Zoom
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factor. It displays only one FFT spectrum at a time.

Source W
Source: CH1

Selects the channel used as the FFT source

. Whincd o W
Window: Rectangle

Selects the FFT window type

YEmS W
Scale:

Selects the vertical scale units

1 .00 w
Vert Scale:

Selects the vertical scale

W

HORI Scale:
Selects the FFT zoom factor

Sets horizontal scale, If the information is more than the quantity displayed to the display

window, more information is displayed by using scroll bar.

You can click the “ON/OFF” button to start FFT math, also you can click this button to stop

FFT math.

3.2.2 Set Reference

Click “ ” in Toolbar to set REF.
The Reference Channel Function:
€ Turn On/Off: Turn on/off the reference channel.
¢ \olt/DIV: Channel the resolution of the reference channel.
¢ Time/DIV: leading the setting of the time base parameters.
Eef E'
[Cion { oFF:

WOLT f DIV | 1.00% w Time [ DIY | 50.00us

Ref Data Len : 0

1

W

You can change the vertical scale of a waveform. The waveform display will contract or

expand relative to the reference level.

User’s Manual
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The Reference Waveform Display Window:

Trig'D 4+ 0.00uv

CHT == .00 Tirme: 5800.0us Sample Rate: 1MHz

Note: If you turn on the “Reference” channel, the load file window will appear.

3.3 Set Horizontal System

The following figure shows the Horizontal System window. It shows the horizontal

parameters settings.

Horizaortsl
Time/Dl
S000us W
Format
=T W

1. Time/DIV: leads the setting of the time base parameters

Time Dl
SO00us W

2. Format: leads the setting of the horizontal format parameters
The time base ranges of the oscilloscope is listed as follows. The horizontal scan speed is

from 4ns/div to 1hour/div.
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In the “Format” menu of the “Horizontal” menu, select the display mode to Y-T, X-V.

Format

YT W

3.4 Set Trigger System

Click “Trigger” in main menu.

The trigger determines when the oscilloscope starts to acquire data and display a
waveform. When a trigger is set up properly, it can convert unstable displays or blank
screens into meaningful waveforms.

If the oscilloscope wants to acquire a waveform, it collects enough data so that it can draw
the waveform to the left of the trigger point. The oscilloscope continues to acquire data
while waiting for the trigger condition to occur. The oscilloscope continues to acquire
enough data so that it can draw the waveform to the right of the trigger point after it
detects a trigger.

The Edge trigger determines whether the oscilloscope finds the trigger point on the rising
or the falling edge of a signal. Select Edge trigger mode to trigger on Rising edge or
Falling edge.

Mode: Select the trigger mode.

[rigger Mode

Edl

The oscilloscope only provides edge trigger mode.

Sweep: Set the sweep mode to Auto, Normal or Single.

Trigger Sweep At v

Trigger Source Marmal
Single

Auto: Acquire waveform even no trigger occurred

Normal: Acquire waveform when trigger occurred.

Single: Acquire waveform when trigger occurred then stop
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Source: You can use the trigger source options to select the signal that the oscilloscope
uses as a trigger.

Trigger Source

CHZ1: Select CH1 as trigger signal
CH2: Select CH2 as trigger signal
Slope: Set the slope to Rising (+) or Falling (-).

Trigger Slope + Irw:

Rising: Trigger on rising edge

Falling: Trigger on falling edge

3.5 Measure Signal

3.5.1 Cursor

Click “Cursor” in main menu.

Cursor | Utility
Source P
Type bk

This method allows you to take measurements by moving the cursors

1. Source

Cursor | Wility  Help
Source P CH1

Type » CH2

The user can set the source to CH1, CH2.

2. Type
| Cursor | Utility
Source P
Type 2 Mane
Craoss
Wertical
Horizontal

There are four types of cursors: Cross, Vertical and Horizontal.
1) Cross

The Cross cursors appear as cross lines on the display and measure the vertical and
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horizontal parameters.

The Cross cursor display window:

Tirme: 100.0us  Sarnple Rate: 1WHz

2) Vertical
The Vertical cursors appear as vertical lines on the display and measure the vertical
parameters.

The Vertical cursor display window:

CHT = 1.00% Time: 500.0us  Sample Rate: 1hiHz

3) Horizontal

The Horizontal cursors appear as horizontal lines on the display and measure the
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horizontal parameters.

The Horizontal cursor display window:

CH1 == 1.00v Tirme: 500.0us  Sample Rate: TMHz

3.5.2 Measure

Click “Measure” in main menu.
The oscilloscope provides 20 parametric auto measurements (12 voltage and 8 time

measurements).

1. Vertical

=-[]"0% Vertical

iy Maximum

9 Minimum

¢ Feak to Peak
¢ Top

¢ Base

i Middle

W EMS

W Amplitude

¢ Mean

@ Cyecle Mean
@ Pozitive Owvershoot

OOO0O0OOOoOoOoodn

¢ NHegative Overshoot

Maximum: Voltage of the absolute maximum level, Measured over the entire waveform

Minimum: Voltage of the absolute minimum level, Measured over the entire waveform
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Peak To Peak: Peak-to-peak = Max — Min, Measured over the entire waveform

Top: Voltage of the statistical maximum level, Measured over the entire waveform

Base: Voltage of the statistical minimum level, Measured over the entire waveform

Middle: Voltage of the 50% level from base to top

RMS: The Root Mean Square voltage over the entire waveform

Amplitude: Amp = Base — Top, Measured over the entire waveform

Mean: The arithmetic mean over the entire waveform

Cycle Mean: The arithmetic mean over the first cycle in the waveform

Preshoot: Positive Overshoot = (Max - Top)/Amp x 100 %, Measured over the entire
waveform

Overshoot: Negative Overshoot = (Base - Min)/Amp x 100 %, Measured over the entire

waveform

2. Horizontal

=I[]*% Horizontal
[] % Period
[] % Frequency
[] @ Rize Time
[] & Fall Time
[ & + Duty Cycle
[ @ - Duty Cycle
[] @+ Pulze Width
[] & - Pulze Width

Period: Time to take for the first signal cycle to complete in the waveform
Frequency: Reciprocal of the period of the first cycle in the waveform
Rise Time: Time taken from lower threshold to upper threshold
Fall Time: Time taken from upper threshold to lower threshold
+Duty Cycle: Positive Duty Cycle = (Positive Pulse Width)/Period x 100%, Measured of
the first cycle in waveform
-Duty Cycle: Negative Duty Cycle = (Negative Pulse Width)/Period x 100%, Measured of
the first cycle in waveform
+Pulse Width: Measured of the first positive pulse in the waveform. The time between the
50% amplitude points
-Pulse Width: Measured of the first negative pulse in the waveform. The time between the
50% amplitude points

3. Clear Measure
Clear all measure items on display screen.

The Measure Display Window:
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CHT — 1.00%

InFormation output

Time: 100.0us  Sample Rate: 1MHz

= CH1
Maxirnurm 2. 10
Period 1.10mS
Frequency 909, 1Hz
+ Duty Cycle  49.6%

Note: The results of the automatic measurements will be displayed on the bottom of the

screen. Maximum 8 results could be displayed at the same time. When there is no room,

the next new measurement result will make the previous results moving left, out of screen.

3.6 The Utility Function

Click the “Menu -> Utility” to get into the “Utility” menu.

The “Utility” Functions:
€ Default Setup
€ Interpolation
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€ Language

3.6.1 Default Setup

Click “Default Setup” in “Utility” menu to load default setups

When you click the Default Setup in Utility menu, the oscilloscope displays the CH1 and
CH2 waveforms and removes all other waveforms.

The oscilloscope set up for normal operation when it is shipped from the factory and can
be recalled at anytime by user.

The Factory Setup function does not reset the following settings:

¢ Language option

€ Date and time

3.6.2 Language

Click “Language” in “Utility” menu.

Lznguzgs 3 . Default (Englich]

There are four languages in “Language” menu. The default language is English.
At the time base 40ns/div or faster, user can use the 3 different interpolation mode to get
waveforms of different smoothness.
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3.6.3 Interpolation

Click “Utility->Interpolation”.

A SEip
alibrate Ctri+Alt+

The Step Interpolation:

CHT == 1.00v Time: 50.00ns  Sample Rate: 48MHz
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The Linear Interpolation:

CH1 == 1.00% Time: 50.00ns

The Sin(x)/x Interpolation:

Tirme: 50.00ns

Note: The default interpolation mode is Sin(x)/x.
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3.7 The Display System

Click “Display” in main menu.
The following figure shows the display system menu. Displays parameters setting.

Display | Cursaor
Type +

rid
Inkensity

¢ Type

¢ Grid

€ Intensity

3.7.1 Type

Click “Type” in “Display” menu.

Display | Cursor LUtility Help

Type M| v | Vectors
¥ | Grid Dots
Intensity

If the Vectors type mode is selected, the waveform will be displayed as following figure.

CHT = 1.00% Time: 200.0ns  Sample Rate: 48MHz
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If the Dots type mode is selected, the waveform will be displayed as following figure.

CHT = 1.00v Time: 200.0ns  Sample Rate: 48MHz

3.7.2 Grid

Click “Display” in main menu.
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The grid shows:

CHT == 1.00W Titme:; 200.0ns  Sample Rate: 483mMHz

Without the grid show:

CHT = 1.00% Sample Rate: 48MHz
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3.7.3 Intensity

Click “Display->Intensity” in main menu.

The following figure shows the intensity dialog. It shows the display parameters setting.

Intensity rs_(|

L

Wawveform |

Gicd |

L

You can change the grid and waveform color intensity in this dialog.
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3.8 Save/Load Menu

Click “File” in main menu to save waveform, setups and screen

File | Wiew Display

H Save Data

Save Setup

Lj Load Data
Load Setup

& Print...

Print Preview

Print Setup

Exit

1. Save Data
Save waveform data
2. Save Setups
Save the current oscilloscope setups to file

Load Menu
Click “File” in main menu to recall saved waveform, setup

File | View Display

H Save Data

Save Setup

Lj Load Data
Load Setup

d= Print...

Print Preview

Print Setup

Exit

1. Load Data
Load the waveform
2. Load Setup
Load the instrument that had saved
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3.9 Print

Click “Print” in File.

1.

File | Wiew Display
._‘z‘ Sawe Data

Save Setup

Load Dakta

B

Load Setup

i Print...
Prink Presview

Prink Setup. ..

Exit

Click “Print” in “File” menu to set the printer to print the current waveform.

2. Click the “PrintPreview” in “File” menu to get into the Preview window.

In “PrintPreview” window, use the = = putton to change the size of the waveform

graph. Click the “Close” button to turn this window off and click the “Print” button to print
the report.

Test Report

Bads z ITEFIED Taas z AL3mER

Hanfek G022BE

NOTE :
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Chapter 4 Application Example

€ Simple Measurement
€ Capturing a Single-Shot Signal
€ The Application of the X-Y

€ Taking Cursor Measurement
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4.1 Simple Measurement

To acquire and display a signal, please do the steps as follows:

Connect signal to CH1 by using probe.

The oscilloscope set the vertical, horizontal, and triggers controls at the best status

automatically. Also, you can adjust the controls to meet your measurement to optimize the

waveform display.

CH1

= O

= D“"[g Vertical

=-0

OOo000000«000000000000

9 Maximum

@ Minimum

¢ Peak to Peak
@ Top

¢ Baze

W Middle

W EMS

W Amplitude

@ Mean

i@ Cyecle Mean
@ Positive Owershoot

¢ Negative Overshoot

Horizontal

@ Period

@ Frequency

W Rize Time

@ Fall Time

@ + Duty Cxcle
@ — Duty Cxcle
@+ Pul=ze Width
@ — Pul=e Width

1. To measure the frequency and “Vpp”, you can do these steps as follows:

2. Click the ] * Frequency pytton, the frequency of the signal display on the bottom of

the waveform interface.

3. Click the[#] % Feak to Fesk  button, the “Vpp” of the signal will also display on the

bottom of the waveform interface.

4. To clear the measurement on the waveform interface, click the button.
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CHT = 1.00v Time: 500.0us  Sample Rate: 1MHz

The results of measure display in Information output.

Information output

= CH1
Peak to Peak 92,11
- Pulse wWidth 254U5

4.2 Capturing a Single-Shot Signal

To capture a single event, it needs to gather some pre-test knowledge of the signal in

order to set up the trigger level and slope correctly. For example, if the event is derived

from 3.3V COMS logic, a trigger level of 1.2 or higher Volts should work on a rising edge.

Do these steps as follows:

1. Setthe probe and the channel attenuations to X 10.

2. Setup the trigger in the Trigger Menu, or in the Trigger Setting window.

1)
2)
3)
4)
5)
6)

Adjust the Trigger Mode to Edge.

Set the Trigger Sweep to Single.

Set the Trigger Source to CH1.

Set the Trigger Slope to “+” which means you select the rising edge.
Adjust the Volts/Div and the time base in a proper range for the signal.

Drag the trigger level sign on the waveform display screen to proper position. It's
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usually higher a little above the normal level.
7) When the trigger conditions are met, data appears on the display representing

the data points that the oscilloscope obtained with one acquisition.

4.3 The Application of the X-Y

X-Y Plot acts to analyze correlation of data of two channels. Lissajous diagram is

displayed in the screen when you use X-Y Plot, which enables to compare frequencies,

amplitudes and phases of counterpart waveform against the reference waveform. This

makes it possible to compare and analyze frequency, amplitude and phase between input

and output.

Do these steps as follows:

1.
2.

6.

Set the probe attenuation to “x10”. Set the switch to “x10” on the probes.

Connect the CH1 probe to the input of the circuit, and connect the CH2 probe to the
output of the circuit.

Adjust the vertical scale and offset to display approximately the same amplitude
signals on each channel.

Select X-Y format at Horizontal window. The oscilloscope will displays a Lissajous
pattern representing the input and the output characteristics of the circuit.

Adjust the scale and offset of the horizontal and vertical to a desirable waveform
display. The following picture shows a typical example.

Apply the Ellipse Method to observe the phase difference between the two channels.

Signal in X-Y Format:

Instruction of the Ellipse Method
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Signal must be
centered in X

17

4
A
/o
‘,/

Sin@ = A/B or C/D, where 6 = phase shift (in degrees) between the two signals.

From the formula above:

0 = *arcsine (A/B) or *arcsine (C/D)

8 must be in the range of (0~11/2) or (311/2~2m) if the main axis of the ellipse is between |
and lll quadrant, . If the main axis is at Il and IV quadrant, 8 must be in the range of
(Tr/2~TT) or (TT~311/2).
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4.4 Taking Cursor Measurements

Use cursors to make time and amplitude measurements on a waveform quickly.
Measure the Peak Frequency or Time of the First Sine Waveform

Do these steps:

Click “Cursor->Source”, select CH1 (select CH2 if you want measure CH2).
Click “Cursor->Type”, select Vertical.

Push left mouse button, and the vertical lines appear.

Drag the mouse button to the point you want to measure.

ok 0 DdhPE

Release the left mouse button, the frequency difference and time difference will be

shown at the status bar.

CHT = 1.00% Time: 500.0us  Sample Rate: 1hHz

Measure the Amplitude of the First Waveform Peak of the Waveform
Do these steps:

Click “Cursor->Source”, select CH1 (select CH2 if you want measure CH2).

Click “Cursor->Type”, select Horizontal.

Push left mouse button, and the Horizontal lines appear.

Drag the mouse button to the point you want to measure.

Release the left mouse button, the voltage difference will be shown at the status bar.

SARE A
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Tirne: 500.0us  Sample Rate: TMHz

Note: Click “Cursor->Type”, select “Cross”, you can measure time and amplitude at one
time.
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Chapter 5 Instructions of Hantek6022BL

The User’s Interface
The Menu System
The Toolbar

The Control Panel
The Status Bar

Input Output Window

® & 6 6 6 O o

Measurement
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5.1 The User’s Interface

on the desk after you finished the software setting

iy
and equipment connecting. Click icon HantelflZEEL to run Hantek6022BL mode.

Multi function virtual signal analyzer |E|
= it
Hant elBOZEEE Hant elBOZZEL
1 2
. Logic—Multi functlon wirtual signal analyzer - = X

[EiIE View Display Cursor  Help l

e @ aln X & ala T8 o 0 |
4 1,1MHZ AM[Samples] x ‘operties X

Hantek60228L(1.0.1) B

+3,2|Dms +6,4|Dms +9,6|Dms +12,Ef0ms +1E»,i|)0ms

!
Channel0 Property Value
Channell |= Sample Length
Sample Le... 1M
Channel2 |2 SampleRate

Channel3 SampleRate 1M

Channeld ) k— 3
Channel5
Channel6
Channel?
Channel8
Channel9
Channel10
Channel11
Channel12
Channel13
Channel14

Channel15

¥ |
5 6

In addition to displaying waveforms, the display area is filled with many details about the
waveform and the logic analyzer control settings.
1. The Main Menu

All settings can be found in the main menu.

The Toolbar

Control Panel

The user can change sampling rate in the panel.

It shows the system time.

It shows the device’s state.

Output Window
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5.2 The Menu System

The Main Menu:

File VYiew Displar Curscr Help

1. File: Load or Save data, setup

[];
m
B
hnl
[+
"
in

il
L3

1
[
i

¥
h=l
'
o+
n
i
1

Export As CSV File: Export data to file as “CSV”
Export As TXT File: Export data to file as “TXT”
Export As BMP File: Export data to file as “BMP”
Print...: Print the current waveform

Print Preview: Preview the current waveform
Print Setup: Setup print type

Exit: Exit Hantek6022BL

2. View: Change the user interface

| L]
b
H
W
¥
5
IS
E:
i

S CATUE Dar

Docking Window: show window or not
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® Status Bar: show status bar or not
® Application Look: show style, blue, black, silver or aqua style.

3. Display: The waveform display setup

® Zoom in: Enlargement waveform view

- : User can do the same thing by scrolling the mouse wheel down.

® Zoom out: Reduction waveform view

b : User can do the same thing by scrolling the mouse wheel up.

Zoom all: Show entire waveform view

4. Cursor: Cursor measure setup

I
s
54
o
it
-

® Source: cursor measure source, CHO to CH15
® Type: show cursor or not
None : cancel the measurement
Vertical: show the measurement

5. Help: Turn on help file
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5.3 The Tool Bar

The following figure shows the tool bar
Baeaad & 5[ X Q)8 Q[T & o N

Export As CSV File: Export data to file as “CSV”
Export As TXT File: Export data to file as “TXT”
Export As BMP File: Export data to file as “BMP”
Print...: Print the current waveform

Print Preview: Preview the current waveform
Print Setup: Setup print type

Zoom In: try it by yourself to see it

Zoom Out: try it by yourself to see it

© ® N o g bk~ wDhPE

Zoom All : show waveform With appropriate size

=
©

Cursor : Measurement

=
[EEN

. None : Cancel the measurement

'_\
N

About : About Information

=
w

Capture: capture waveform one time
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5.4 The Control Panel

The following figure shows the Control Panel. It shows the control parameters settings.

Froperties x
\Hant=RE0ZZEL (1. 0. 1) |
Froperty Value

Sample Le... IM

SampleRate i

1. Hantek6022BL(1.0.1): Name and version information of the software.
2. Sample length: the length of sample points.

3. Sample Rate: the sampling rate

5.5 The Status bar

The following figure shows the status bar. It shows the status bar parameters settings.

u | fos-03-2014 13- 368

) 1

1. Connected the equipment or not

2. Time now
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5.6 The Output Window

The following figure shows the Output Window. It shows the output window settings.

1 2

+32Pnu&
Channel0 I II
Channel1
Channel2
Channel3
Channel4
0 ET T
Channel6
Channel7
Channel8
Channel9
Channel10
Channel11
Channel12
Channel13
Channel14

Channel15

Channel Name
Time Scale
Waveform
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5.7 Input Connector:

2

1. Button: press the button down to run Hantek6022BL software.

2. Pins : connect peripheral equipment

5.8 The Measurement

The following figure shows the Measurement

1. Click the button of cursor, you can see the picture

Cursor : /ATime = +976.00us. /A Frequency = 1.025KHz /. Transition = 2 /A.Cycles = 1.

® Time : the time of the two measurement line

® Frequency: the frequency of the two measurement line
® Transition : the transition of the two measurement line
® Cycles : the cycles of the two measurement line

2. Click on the mouse in the position of trying to start the measurement
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3.  Move the mouse to the position fo trying to end the measurement
Appendix

€ Appendix A: Specifications

€4 Appendix B: General Maintenance
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Appendix A: Specification

Specifications Table:

Oscilloscope Features(Hantek6022BE)

Input

Max. sample rate Real-time sampling:48MS/s
Channels 2 Channels

Bandwidth 20MHz (-3dB)

Vertical resolution

8 bits/channel

Gain range 20mV~5V/div@x1 probe(20mV,50mV,100mV,200mV,
500mV,1V,2V,5V/div 1,2,5 sequence)
200mV~50V/div@x10 probe
2V~500V/div@x100 probe
20V~5KV/div@x1000 probe

Range 8 divisions

Offset level +/-4 divisions

Coupling DC

Offset increments 0.02 div

Impedance 1M ohm

DC accuracy +/-3%

Max. Input +/- 5V

Input protection

35Vpk(Without external attenuation DC + peak AC < 10kHz)

Display mode

Y-T, X-Y

Timebase

Timebase range

1ns/div~5000s/div(1ns,2ns,5ns,10ns,20ns,50ns,100ns,200ns,
500ns,1us,2us,5us,10us,20us,50us,100us,200us,500us,
1ms,2ms,5ms,10ms,20ms,50ms,100ms,200ms,500ms, 1s,2s,
5s,10s,20s,50s,100s,200s,500s,1000s,2000s,5000s/div 1,2,5

sequence)
Range 10 divisions
Buffer Size MAX.1M samples
Trigger
Type Edge trigger: Rising edge, Falling edge
Mode Auto, Normal and Single
Autoset Yes
Range 8 divisions
Trigger level +/-4 divisions
Settabillity 0.02 div increments
Math
Measurements Vp-p, Vmax, Vmin, Vmean, Vrms, Vamp, Vtop, Vbase,
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Vmid,positive overshoot, negative overshoot, cycle mean, cycle
RMS, period, frequency, positive pulse width, negative pulse
width, rise time (10%~90%), fall time (10%~90%), positive duty

cycle, negative duty cycle

Math Addition, Subtraction, Multiplication, Division

FFT Rectangular, Hanning, Hamming, Blackman Window
Logic Analyzer Features(Hantek6022BL)

Channel 16

Max. Impendance | 1MQ(C=7.5pF)

Max. Voltage 0v~5.5v

Max. Sample 48M

Bandwidth 10MHz

Compatible Input TTL, LVTTL, CMOS

Memory Depth 1M/CH

General Features

Interface Universal Serial Bus(USB 2.0)

Power No external power source required.
Bus-powered from USB

Demension 200mm x100mm x 35mm

Weight 0.3KG

Standard Probe 2 x PP-80
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Appendix B: General Maintenance

General Care

Do not store or leave the oscilloscope where the device will be exposed to direct sunlight

for long periods of time.
Caution

To avoid damages to the device or probes, do not expose them to sprays, liquids or
solvents.
To avoid damages to the surface of the device or probes not use any abrasive or chemical

cleaning agents.
Cleaning

Inspect the device and probes as often as operating conditions require. Make sure the
device disconnect form all power sources.

To clean the exterior surface, perform the following steps:

1. Remove loose dust on the outside of the oscilloscope and probes with a lint-free cloth.
Use care to avoid scratching the clear glass display filter.

2. Use a soft cloth dampened with water to clean the device.
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